
Dostek Support Guide

New! Dostek is now part of Memex

Dostek products and expert technical support are now available exclusively from
Memex and Memex dealers.

Memex has been recognized as a global leader of the manufacturing M2M (machine-
to-machine) field. Its flagship product, MERLIN, is the premier industrial Internet
platform solution for manufacturing. MERLIN is an industrial Internet communications
platform that includes a hardware and software machine monitoring solution, a
Manufacturing Execution System (MES) for Overall Equipment Effectiveness (OEE),
and a Direct/Distributed Numerical Control System (DNC).

About This Guide

This guide explains support options and procedures for users of Dostek DNC software
and Dostek Behind-the-Tape Reader interfaces.
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1 Support Options

Support options for Dostek DNC software and Dostek Behind-the-Tape Readers
include:

• Self support (including emergency or after-hours support)
• On-site support
• Web-based remote support
• E-mail and telephone support

Self Support and Emergency After-Hours Support

If you encounter a problem, and it's after hours or you would like to fix the problem
yourself, don't worry. See the instructions in Section 2, "Self Support."

On-site Support

To arrange a site visit by a skilled technician, call Memex at 905-635-3042.

Web-based Remote Support

Web-based remote support is a fast and affordable way to obtain training or expert
help installing and configuring software and troubleshooting problems.

Using remote support is easy.  All you need is a high-speed Internet connection. To
get started, see Section 3, "Contacting Memex."

E-mail and Telephone Support

For e-mail and telephone support, see Section 3, "Contacting Memex." 
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2 Self Support and Emergency After-hours Support

The following topics help you quickly resolve problems on your own, in an emergency,
or outside of normal business hours:

• Handling an After-hours Emergency

• Using Sample CNC Configurations 

• Using Help 

• Using Communication Testing and Troubleshooting Help 
¤ RS-232C signals, ports and cables
¤ Test procedures
¤ Frequently-asked questions 

• Fixing a CNC Communication Problem 

• Installing and Configuring Dostek DNC 

• Fixing a Software Operation Problem

•

Note:

› To get the latest help files, test procedures and diagnostic software, download the
Dostek DNC Support Update at http://www.memex.ca/dostek.

2.1 Handling an After-Hours Emergency

To solve a problem such as a computer failure or a communication error when support
is not available: 

• If your computer and software work, but you are having trouble communicating
with a machine, see Section 2.5, "Fixing a CNC Communication Problem."

• If your computer or Dostek DNC software stop working, install your Dostek DNC
software on another computer. If you can't find your Dostek DNC software disk,
download the free trial from the Memex Web site. It works for 10 days without a
license. 

• If you encounter a problem with your network, COM port or cable, install your
Dostek DNC software on a laptop computer and connect it directly to the machine.

To ensure you can quickly recover from a problem, plan ahead. For example:

• Prepare a back-up computer with a COM port, and prepare any back-up cables you
need. Configure and test your Dostek DNC software on your backup computer. 

• You can connect your back-up computer directly to the machine to bypass your
network cables and devices.

• Test your back-up computer periodically to ensure it works when you need it.

2.2 Using Sample CNC Configurations

To save time, use Dostek DNC's sample CNC configuration files. Samples are provided
for more than 100 CNC models, and they include the information you need to config-
ure your CNC (in the "Notes" tab). 

To use a sample configuration, open the Dostek DNC Configuration window, and then
click Import sample configuration in the File menu.
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2.3 Using Help

To view Dostek DNC's detailed help topics, you can:

• Click Help in the menu in any Dostek DNC window. 

• Open Dostek DNC Navigator to the "Help" tab for access to all help documents.
Click Master Help to view all help documents at once. To start Navigator, click
Navigator in the Help menu in Dostek DNC, or in the Dostek DNC folder in the
Windows Start Menu. 

• Click the "Search" tab to quickly find topics. 

2.4 Using Communication Testing and Troubleshooting Help

The Dostek DNC Communication Testing and Troubleshooting help module (Comtest)
includes detailed information including:

• Fixing CNC communication problems 

• Testing ports and cables 

• Recommended cable diagrams 

• Frequently-asked questions

2.5 Fixing a CNC Communication Problem

If you encounter a problem when you upload, download or drip feed:

 Write down, print or save a screen image of every error message displayed
on the computer or CNC (see Section 4.1, "Sending Screen Images").

 If the CNC displays an alarm, find the alarm description in the CNC manual
and write it down or make a copy of the manual page.

 Use the sample device configuration provided for your CNC, and carefully
read the notes provided in the "Notes" tab. To use a sample configuration:

a) Open Dostek DNC Configuration (DConfig).
b) Click Import sample configuration in DConfig's File menu. The

file open dialog opens.
c) Select a sample configuration, and then click Open. The sample

configuration is imported.
d) Click DConfig's Notes tab, and then read the comments and

instructions.

 Keep notes. Before you change anything (on the computer or the CNC), write
down the current setting, the new setting, and the reason for the change.

 View the Communication Testing and Troubleshooting help file for detailed
recommendations for typical communication problems. Go to the Problem
Topics section and find the topic heading that most closely describes your
problem. For a link to the help file, see Dostek DNC Navigator's Help tab.

2.6 Installing and Configuring Dostek DNC

To ensure success when installing and configuring Dostek DNC software:

• Carefully follow the on-screen instructions during installation, and complete each
step of the Dostek DNC First-Time Setup Wizard. 

• Read the Dostek DNC Getting Started Guide help. It provides a complete overview
of the Dostek DNC software in just a few minutes. 

• Use the supplied sample CNC configurations (topic above).
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2.7 Fixing a Software Installation Problem

If you encounter a problem while installing the Dostek DNC software:

 Write down, print or save a screen image of every error message (see
Section 4.1, "Sending Screen Images."

 To install the software, log on to your computer using an account with
administrator privileges.

 Ensure that all other Windows applications are closed before starting the
installation. 

 Carefully read and follow all messages and instructions displayed on your
computer screen during installation. 

 Fully complete the Dostek DNC First-Time Setup Wizard. It opens
automatically when the software installation is completed. 

 Try installing Dostek DNC on a different computer. There may be a problem
with your computer. Windows computers can become unstable over time due
to viruses, spyware, registry corruption, installation of non-compliant
applications, and so on.  

2.8 Fixing a Software Operation Problem

If you encounter a problem when you open the Dostek DNC software or perform a
specific task:

 Write down, print or save a screen image of every error message (see
Section 4.1, "Sending Screen Images."

 Write down exactly what you were attempting to do when the problem
occurred, including the commands or key sequences you pressed.

 Restart the computer and try again. Windows computers can become
unstable or low on resources.

 Ensure the computer's disk drive is not full.
 If you are attempting to access files on a network resource, ensure the

network is working properly and you have sufficient network privileges. 

2.9 Fixing File Access Problems

If Dostek DNC reports a file access problem (access denied or unable to create or write
to a file), your Windows user account may not have permission to access a file or
folder. This can happen if you install Dostek DNC using an administrator account and
then use Dostek DNC with a normal user account, or when you change file or folder
permissions after installing Dostek DNC. 

If you encounter a problem accessing a Dostek DNC configuration file:

• Open Dostek DNC Configuration, change a setting, and then click Save in the File
menu. If an error message is displayed, your user account may not have permis-
sion to write to Dostek DNC's Settings folder.

If you encounter a problem editing, creating or deleting a part program file:

• Open the file in Windows Notepad, make a change, and then click Save in the File
menu. If an error message is displayed, your user account may not have permis-
sion to write to the selected file and folder.

To correct a file access problem, either:

• Search the Web for "windows change file permissions," and follow the instructions.

• Contact your IT help desk or consultant.
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3 Contacting Memex

To obtain fast and accurate technical support from Memex, review the following tips:

• Write down your observations, including all alarm codes and error messages, and
a brief description of exactly what you were doing when the problem occurred. 

• Provide an accurate description of the problem. Be specific and avoid slang and
ambiguous words. For example, instead of saying "It quits when I download," say
"When I'm sending a file from the computer to the CNC, the CNC indicates alarm
86 and the Dostek DNC software stops after sending 14 percent of the file and
displays the message 'XOff char received'."

• Provide detailed information about your application:

¤ The manufacturer and model number of the machine's numerical control.
¤ Your Dostek DNC software version number and serial number. To find

this information, open Dostek DNC Navigator, and then select the About
tab.

¤ Your computer's operating system. For example: "Windows 7 64-bit
edition."

¤ Your communication hardware. For example: "Computer's built-in COM
port," or "Moxa 5110 Ethernet/serial adapter."

• Provide your full contact information:

¤ Full name
¤ Company name
¤ Telephone number
¤ E-mail address

• If practical, send the following data files to Memex by e-mail:

¤ Dostek DNC configuration files (see Section 4.2, "Sending Files").
¤ One or more of the CNC part program files you used when the problem

occurred.
¤ A screen image of Dostek DNC error messages (see Section 4.1,

"Sending Screen Images").
¤ If you are using a Dostek Model 440A BTR, send your BTR's configuration

information (see Section 4.5, "Sending BTR Configuration").

To view the Memex support polcy: visit memex.ca,
point to Resources in the menu and then click
Technical Support Policy.

Support
Policy

http://support.memex.ca
http://www.memex.ca/resources/support/

Internet

905-635-3042
8am - 5pm EST (UTC-4)
Monday to Friday

Telephone

support@memex.caE-mail
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4 Sending Information

This section helps you send information such as screen images, files, captured CNC
output data and BTR configuration data to Memex by email.

4.1 Sending Screen Images

To capture a screen image (such as an error message) and send it to Memex:

1. Press the computer's PrtScrn key. A snapshot of the current screen image is
saved to the Windows Clipboard. (Note: To save a snapshot of only the current
window rather than the entire screen, press Alt+PrtScrn.)

2. Click Run in the Windows Start menu. The Run dialog opens.

3. Type MSPAINT and then press Enter. Windows Paint (graphic editor) opens.

4. Press Ctrl+V. The captured screen snapshot is pasted into Windows Paint. 

5. Click Save as in Paint's File menu. The Save As dialog appears:

6. On the "Save As" dialog:

a) Select a file location using Save in. [1]
b) Type a file name in the File name box. [2]
c) Select "PNG" in Save as type. [3] Selecting "PNG" reduces the size

of the file so it is easier to send by e-mail.
d) Click Save. The file is saved. [4] 

7. Click Send in Paint's File menu. A new email message opens with the saved
image attached. Type support@memex.ca in the To box, and then click Send.
(Note: If an e-mail client is not installed on your computer, see Section  4.2,
"Sending Files.")
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4.2 Sending Files

This section explains how to send files to Memex support, including:

• Dostek DNC configuration files

• Dostek DNC log files

• Data files

• Dostek MultiPort DNC messages

• Dostek MultiPort DNC received file

• Dostek MultiPort DNC feedback message file

To send files to Memex, attach the files to an e-mail message addressed to
"support@memex.ca".

If your computer does not have an e-mail client installed, copy the files to another
computer using a USB memory device, a removable disk, or a shared network folder.

Sending Dostek DNC Configuration Files

To send Dostek DNC configuration files:

1. Open Dostek DNC Configuration (DConfig).

2. Point to Explore in DConfig's File menu, and then click Dostek DNC\Settings.
The Dostek DNC "Settings" folder opens in a new Explorer window.

3. Select one or more files, or press Ctrl+A to select all files.

4. Point to Send in Explorer's File menu, and then click Mail Recipient. A new
e-mail message is opened, with the selected files attached.

Note:

› If the computer does not have an e-mail client installed, click Copy to
folder in Explorer's Edit menu, save the files to a network folder or remov-
able media, and then attach the files to an email message using another
computer..

Sending Dostek DNC Log Files

To send Dostek DNC log files, follow the procedure above, except click Dostek
DNC\Log in step #2.   
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Sending Data Files

To send data files:

1. Right-click the Windows Start button, and then click Explore in the context
menu. A new Windows Explorer window opens.

2. Browse to the folder containing the data files you wish to send.

3. Select one or more data files.

4. Point to Send to in Explorer's File menu, and then click Mail Recipient. A new
e-mail message is opened, with the selected files attached.

Notes:

› If the computer does not have an e-mail client installed, click Copy to folder in
Explorer's Edit menu, and save the files to a network folder or removable media.

› If you are sending a large number of files, or files that are very large, use WinZip
(or similar) file compression software to condense and combine the files into a
single file.

Sending Dostek DNC Remote Server Messages

To send Dostek DNC Remote Server (DRemote) message and log files:

1. Click Copy messages to clipboard. in DRemote's Help menu. All recent
messages are copied to the Windows Clipboard. 

2. Open a new e-mail message, and then paste the messages from the Windows
Clipboard into the message.

Notes:

›  If the computer does not have an e-mail client installed, open a new Notepad or
Word document and then paste the messages into the new document. Save the
document to a file, and copy the file to another computer using a removable disk
or shared network folder.

› To send recent messages for one specific CNC only:

a) Select the CNC in DRemote's CNC list.

b) On the menu, click Channel, point to View and then click
Messages.          
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Sending Dostek DNC Remote Server Received File

To send the content of the most recently received file for a specific CNC: 

1. Select the CNC in DRemote's CNC list.

2. Point to View in DRemote's Channel menu, and then click Last received file
The most recently received file is displayed in the view window. 

3. Open a new e-mail message, and then paste the messages from the Windows
Clipboard into the message.

Note:

› If the computer does not have an e-mail client installed, open a new Notepad or
Word document and then paste the messages into the new document. Save the
document to a file, and copy the file to another computer using a removable disk
or shared network folder.

Sending Dostek DNC Remote Server Feedback Message File

To send the most recent feedback message issued by Dostek DNC Remote Server
(DRemote) for a specific CNC:

1. Point to Explore in DRemote's Tools menu, and then click Dostek DNC\Log.
The Dostek DNC Log folder opens in a new Explorer window.

2. Select the .fbk file (file with extension ".fbk") matching the name of the CNC.

3. Point to Send in Explorer's File menu, and then click Mail Recipient. A new
e-mail message opens, with the selected file attached.

Note:

› If the computer does not have an e-mail client installed, you can save the
results to a network folder or removable media, and then send the files
using another computer. To save the files, click Copy to folder in
Explorer's File menu.
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4.3 Sending Captured CNC Output

This section explains how to:

• Use Dostek DNC Terminal (DTerminal) to capture data sent from the CNC to the
computer. 

• Send the captured data to Dostek.

To capture and send received data:

1. Open Dostek DNC Com Test Terminal (DTerminal):

a) If you are using the Dostek DNC File Manager (DFileMgr), click Com
Test Terminal in DFileMgr's Supervisor menu. 

b) If you are using Dostek DNC Remote Server (DRemote), click Com
Test Terminal in DRemote's Tools menu. Note: To use DTerminal
with a COM port, you must "disconnect" the channel. See Appendix
A, "Disconnecting a MultiPort DNC Channel."

DTerminal's Device Configuration window opens. 

2. Select the CNC whose data you wish to capture, and then click OK. 

3. An information message may appear. Click OK. DTerminal indicates "Connected"
on a green background. If DTerminal is unable to open the COM port, the port
may already in use by another window, or the port may not be configured
properly. 

4. Configure the DTerminal Options menu as shown. Ensure Flow Control is
"None," and only "Display typed characters" and "Display control symbols" are
checked. 
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5. Set Flow Control to None.

6. Click Capture to log file in DTerminal's File menu. The "Open communication
log file" window opens.

7. Select an existing log file, or type the name of a new log file, and then click OK.

Note: Use the extension .log or .txt for the log file. This makes it easier to open
the file in a text editor or attach it to an e-mail message.

8. Go to the CNC and send the data you wish to capture. Captured data scrolls in
the DTerminal window, and usually appears something like the example below: 

Note:

› The "^@" and "^J" symbols represent the "Null" and "Line feed" control
character that are normally not visible. This is normal. You may see other
"^" symbols.

9. Click Capture to log file in DTerminal's File menu again. DTerminal stops
capturing data. The "End capture" prompt appears.

10. You can save or edit the captured data or copy the data to the Windows
clilpboard. To send the captured data to Memex by e-mail:

a) Click Clipboard. The captured data is copied to the Windows
clipboard.

b) Open a new e-mail message, and then paste the captured data into
the e-mail message.

Note:

› If the computer does not have an e-mail client installed, paste the captured
data into a Notepad or Word document, save the document to a network
folder or removable drive, and then send the document by email using
another computer.  
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4.4 Sending Component Version Information

Dostek DNC includes an application that reports the current version of all the software
components it uses.

To send a software component version information to Memex:

1. Open Dostek DNC Navigator.

2. Select the Navigator's Test tab, and then click Version Information. The
Component Version Info window opens. It displays a list of all software
components and the current version of each.

3. In the Component Version Info window, click Copy to Clipboard. The version
information is copied to the Windows Clipboard.

4. Open a new e-mail message, and then paste the captured data into the e-mail
message.

Note:

› If Version Information is not visible in the Test tab, open Dostek DNC's compo-
nent version information window manually:

a) Open Windows Explorer.

b) Browse to the "Dostek DNC" folder (usually "C:\Dostek DNC,"
"C:\Program files\Dostek DNC" or "C:\Program files (x86)\Dostek
DNC."

c) Locate and double-click DComponentVersionInfo.

› If the computer does not have an e-mail client installed, save the copy the
captured file to another computer by a removable drive or a shared network
folder.
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4.5 Sending BTR Configuration

The Dostek DNC Com Test Terminal application includes a feature to capture configu-
ration information from a Dostek Model 440A Behind-the-Tape Reader (BTR).

To send 440A BTR configuration information to Memex:

1. Ensure the 440A BTR is not already in use. The BTR's 7-segment indicator
displays one of the following three symbols: 

2. Click Query in DTerminal's BTR440A menu. (Requires DTerminal version
2006.22A or later).  

DTerminal sends a series of commands to the 440A BTR to capture the configu-
ration information. The BTR indicates "C" (command mode) for a few seconds
during this process. The Results window opens with a list of the BTR configura-
tion information. 

3. Click Copy results to Windows Clipboard. The results are copied to the
Windows Clipboard.

4. Open a new e-mail message, and then paste the captured data into the e-mail
message.

Notes:

› To download the latest version of the DTerminal application, visit
www.memex.ca/dostek, click Dostek Support, and then download the Support
Update.

› If the computer does not have an e-mail client installed, save the copy the
captured file to another computer by a removable drive or a shared network
folder.
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Appendix A - Disconnecting a Remote DNC Channel

This appendix explains how to disconnect a CNC channel in the Dostek DNC Remote
Server application so you can capture received data from the CNC using the Com Test
Terminal (DTerminal) application.

Capturing data received from the CNC is explained in Section 4.3, "Sending Captured
CNC Output."

When you are using the Dostek DNC Remote Server application (DRemote), you must
"disconnect" the CNC channel before you can capture data using DTerminal.

To disconnect the CNC channel:

1. Select the CNC whose data you wish to capture in the MultiPort DNC channel list:

The selected channel is highlighted.

2. On the DRemote menu, click Channel, and then Disconnect. The channel's
COM port is released (closed) so the port can be opened by the DTerminal
application.
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